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Chapter 1. Release Notes for version 12.1.7

Contains information about new features, defect fixes, and known issues in Unica Campaign and Optimize that HCL
releases as part of a scheduled software release.

System requirements and compatibility

Unica Campaign is part of the Unica suite of products. Unica Campaign version 12.1.7 requires Unica Platform 12.1.7

Where to find complete system requirement and compatibility information

For a list of Unica product versions compatible with this product and a list of third-party requirements for this product,

see the Recommended Software Environments and Minimum System Requirements document.

You can also access this document by selecting Help > Product documentation when you are logged in to Unica.

Prerequisites for using Unica Campaign

Before you begin using Unica Campaign, confirm that your environment meets the following requirements.

« For an improved user experience, use at least a 21" screen.

« For an improved user experience, set your screen resolution to 1600 x 900. Lower resolutions can result in
some information not being properly displayed. If you use a lower resolution, maximize the browser window to
see more content.

« A mouse is best for navigating in the user interface.

» Do not use the browser controls to navigate. For example, avoid using the Back and Forward buttons. Instead,
use the controls that are in the user interface.

« If pop-up blocker (ad blocker) software is installed on the client machine, Unica Campaign might not function
properly. For best results, disable pop-up blocker software while running Unica Campaign.

« Ensure that the technical environment meets the minimum system requirements and the supported
platforms.*

« The correct browser and versions must be used.*

« Clear the browser cache after upgrading or applying any fix pack. This only needs to be done once, after the
application is updated.

« If you use Internet Explorer (IE) with Unica Campaign or any module that uses Unica Campaign flowcharts
(Unica Deliver, Unica Optimize, Unica Interact, Unica Collaborate): To log in multiple times to view side-by-
side information, open IE and log in to Unica. Then select File > New Session in the IE menu bar. In the new IE

browser window, log in to Unica as the same or a different user.

! Important: Do not use any other method to open multiple sessions. For example, do not open a new
tab; do not open another browser session from the Start menu or desktop icon; and do not use File >

New Window in IE. These methods can corrupt information that is shown in the application.
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*For details on the items indicated by an asterisk, see the Unica Recommended Software Environments and Minimum

System Requirements.

Unica Campaign documentation roadmap

Unica Campaign provides documentation and help for users, administrators, and developers.

Table 1. Get up and running

Task

Documentation

Find out about new features, known issues, and

limitations

Unica Campaign Release Notes

Learn about the structure of the Unica Campaign

system tables

Unica Campaign System Tables and Data Dictionary

Install or upgrade Unica Campaign

One of the following guides:

« Unica Campaign Installation Guide
« Unica Campaign Upgrade Guide

Unica Insights Reports for Unica Campaign

Unica Insights Installation and Configuration Guide

Implement the IBM Cognos® reports provided

with Unica Campaign

Table 2. Configure and use Unica Campaign

Unica Reports Installation and Configuration Guide

Task

Documentation

- Adjust configuration and security set-
tings

« Prepare Unica Campaign for users

* Run utilities and perform maintenance

* Learn about integrations

Unica Campaign Administrator's Guide

« Create and deploy marketing campaigns

- Analyze campaign results

Unica Campaign User's Guide

Improve flowchart performance

Unica Campaign Tuning Guide

Use Unica Campaign functions

Macros for HCL Unica
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Table 3. Integrate Unica Campaign with other HCL products

Task

Documentation

Integrate with Acoustic

Campaign and Acoustic Integration Guide for IBM Marketing
Cloud

Integrate with Coremetrics

Unica Campaign Administrator's Guide: How to configure the in-

tegration

Unica Campaign User's Guide: Targeting IBM Digital Analytics
segments in Campaigns

Integrate with Unica Plan

Unica Plan and Unica Campaign Integration Guide

Integrate with Opportunity Detect

Unica Campaign Administrator's Guide: How to configure the in-

tegration

Opportunity Detect Administrator's Guide and Opportunity Detect

User's Guide: How to administer and use the product

Integrate with Unica Deliver

Unica Campaign Installation and Upgrade guides: How to install

and prepare Deliver components in the local environment.

Unica Deliver Startup and Administrator's Guide: How to connect

to the hosted messaging resources.

Unica Campaign Administrator's Guide: How to configure offer in-

tegration.

Integrate with IBM SPSS Modeler Advantage En-
terprise Marketing Management Edition

Unica Campaign and IBM SPSS Modeler Advantage Enterprise
Marketing Management Edition Integration Guide

Integrate with IBM WeatherFX.

You can integrate IBM WeatherFX with Campaign so that you can
pull weather events into your marketing campaigns. Unica Cam-
paign version 9 and version 10 users can integrate with Weather-
FX by using the UBX toolkit.

Integrate with Unica Director.

Unica Director Installation Guide: You can integrate Unica Di-
rector with Campaign so that you can get status of all the run-
ning/completed/failed flowcharts, migrate Campaigns from one
Unica Campaign environment to other, download/delete flow-

chart logs etc.

Integrate with Journey

Unica Campaign can integrate with Journey so that a continuous
communication with users can be established based on the in-
puts from Campaign.
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Table 3. Integrate Unica Campaign with other HCL products (continued)

Task

Documentation

Refer Campaign Administrators guide > Unica Campaign and Uni-

ca Journeys integration

Integrate with Link

Unica Campaign uses Link capabilities of connectors which in-
clude the configuration and provisioning to connect to any deliv-
ery channel.

Refer Campaign Administrators guide > Unica Campaign and Uni-
ca Link integration

Integrate with Segment Central

Unica Campaign can integrate with Segment Central so that a
segments can be created and managed based on the inputs from
Campaign.

Integrate with Audience Central

Unica Campaign can integrate with Audience Central so that a au-
diences can be identified and managed based on the inputs from
Campaign.

Table 4. Develop for Unica Campaign

Note: Additional integrations may be available that are not listed in this table.

Task

Documentation

Use the REST API

See the Unica Campaign REST API

Use the SOAP API

« See the Unica Campaign SOAP API Specification
» JavaDocs in devki t s\ Canpai gnSer vi cesAPI

Table 5. Get help

Develop Java™ plug-ins or command-line exe-

cutables to add validation to Unica Campaign

« See the Unica Campaign Validation PDK Guide

» Java-docs in devki t s\ val i dati on

Task

Instructions

Open online help

When using the Unica Campaign application:
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Table 5. Get help (continued)

Task Instructions

1. Choose Help > Help for this page to open a context-sensi-
tive help topic.

2. Click the Show navigation icon in the help window to dis-
play the full help.

You must have web access to view context-sensitive online help.
Contact Support for more information about accessing and in-
stalling Knowledge Center locally for offline documentation.

Get PDFs When using the Unica Campaign application:

» Choose Help > Product documentation to access Unica
Campaign PDFs.

» Choose Help > All Unica documentation to access all
product PDFs.

« Click the links for PDFs during the installation process.

Google Chrome and Microsoft Edge configuration

Recently, the browsers Google Chrome and Microsoft Edge updated a security fix and this security fix affects the
access of Unica applications. We have received some issues from our customers like:

« issues with Ul
« unable to edit flowcharts
- getting logged out from Unica

These issues are observed due to the change of behavior in browsers after applying the security fix. Applying the
security fix automatically enables Origin-keyed Agent Clusters by default. If the setting Origin-keyed Agent Clusters
by default is enabled automatically, it prevents changes in document referrer and domain values so that malicious
websites cannot execute any type of impersonation. The setting Origin-keyed Agent Clusters by default existed
earlier as well, but was not enabled by default.

If you update Google Chrome or Microsoft Edge to the latest version, you will observe the earlier mentioned issues.
Because of how Unica is designed and because the Unica suite is deployed over multiple JVMs, it is essential that
you disable the Origin-keyed Agent Clusters by default setting for Unica to function correctly and to provide a good

user experience.

As a solution, we recommend that you perform the steps mentioned in the following Knowledge Base article: https://

support.hcltechsw.com/csm?id=kb_article&sysparm_article=KB0107185.


https://support.hcltechsw.com/csm?id=kb_article&sysparm_article=KB0107185
https://support.hcltechsw.com/csm?id=kb_article&sysparm_article=KB0107185
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Note: The update to Microsoft Edge browser is very recent and the Knowledge Base article is not yet updated

for the Microsoft Edge browser.

The CliffsNotes solution is as follows:

1. Open your browser and navigate to one of the following URLs based on your browser:
> Google Chrome: chrome://flags/#origin-agent-cluster-default
> Microsoft Edge: edge://flags/#origin-agent-cluster-default
2. From the dropdown of the highlighted parameter Origin-keyed Agent Clusters by default, select bi sabl ed.
3. At the bottom of the page, click the Apply Changes button.
4. Log out of Unica applications, log back in, and verify if everything is working as expected.

New features and changes in version 12.1.7

Unica Campaign 12.1.7 includes a number of new features and changes. These are listed underneath.

For a list of newly supported and discontinued platforms, see the Recommended Software Environments and

Minimum System Requirements guide.

Upgrade Paths

Unica Campaign supports the following upgrade paths:

*121x-121.7
*12.1.0x - 12.1.7

Customers on versions earlier than 8.6.x must:

« perform a Fast Upgrade from existing version to version 8.6.0 (for more information, see HCL Unica 8.6.0
Fast Upgrade Guide).
- perform a Fast Upgrade from version 8.6.0 to version 12.1.0 (for more information, see HCL Unica 12.1.0 Fast

Upgrade Guide).
- perform an in-place upgrade from version 12.1.0 to version 12.1.7.

Customers on versions earlier than 11.1.x.x can:

- perform a Fast Upgrade from existing version to version 12.1.0 (for more information, see HCL Unica 12.1.0

Fast Upgrade Guide).
- perform an in-place upgrade from version 12.1.0 to version 12.1.7.

Customers on versions 11.1.x.x/12.0.x.x can use one of the following options for upgrade:


chrome://flags/#origin-agent-cluster-default
edge://flags/#origin-agent-cluster-default
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 Option 1
- perform an in-place upgrade from existing version to version 12.1.0.
- perform an in-place upgrade from version 12.1.0 to version 12.1.7.
- Option 2
o perform a Fast Upgrade from existing version to version 12.1.0 (for more information, see HCL Unica
12.1.0 Fast Upgrade Guide).
- perform an in-place upgrade from version 12.1.0 to verison 12.1.7.

Postgres as SystemDB

In version 12.1.7, Unica Campaign introduces compatibility by adding support for Postgres as the SystemDB. This
enhancement provides users with the flexibility to seamlessly integrate Unica Campaign with Postgres, offering a

robust and scalable solution for managing system databases.

Unica products communication using internal server URL

With support for internal server URLs in pod-to-pod communications, there's no longer a necessity for internal calls to
route through load balancers.

Campaign Journey integration for multi partitioning support in journey

Journey now supports multi-partitions. This enhancement ensures that Campaign Journey integrations seamlessly

align with partition configurations, making the entire process partition-aware.

External Callout - ability to specify fields/params as part of ExternalCallout node in Platform
configuration

External Callout functionality has been elevated to a new level of flexibility. Users can now seamlessly provide
configuration parameters directly to the registered callouts. This empowers users to effortlessly supply inputs to the
callouts without the need for constant modification, enhancing the adaptability and efficiency of your workflow.

Real time updates for concurrent users and lock-unlock

In version 12.1.7, users can now see real-time notifications for ongoing collaborative activities, such as when another

user is actively engaged in working on a flowchart or when a flowchart is being locked or unlocked.

Mark or identify the columns used in flowchart from the mapped tables and columns

The Column In Use feature, introduced in this release, serves as a valuable tool for users engaged in data cleanup
efforts. This functionality is crafted to empower users in identifying and managing columns or tables that are no
longer in use. By leveraging the insights provided by the Column In Use column, users can make informed decisions
about the removal of redundant elements, promoting enhanced data efficiency and organizational clarity within their

system.
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Run the blue process boxes, even if we have an unconfigured output PB somewhere in flowchart

Campaign v12.1.7 introduces a significant improvement allowing the execution of blue process boxes even in

instances where any of the underlying red process boxes are unconfigured

AngularJS Library version used with Unica Campaign Deep Search Feature

In this release of Campaign, the deep search feature has undergone a significant transformation. While the user
experience (UX) remains consistent, the underlying code has been completely restructured to eliminate the use of
AngularJS. This transition was imperative as AngularJS had been deprecated, posing potential vulnerabilities. Users
can now enjoy the familiar and seamless deep search experience with the added assurance of an updated and secure

codebase

Execute deliver mailing directly from deliver process box

This enhancement offers a more efficient and user-friendly experience, allowing users to seamlessly trigger mailing
directly from the deliver PB.

Unica Link enhancement

In the latest release, users can now enjoy an enhanced copy-paste functionality in Link, enabling the copying of
Link process boxes, pasting templates with Link PB, and duplicating flowcharts with PB. This update is designed to
provide a more intuitive and time-saving experience for users engaged in campaign design. Notably, precautions have

been taken to ensure that older action IDs are not utilized during the copy-paste process for Link process boxes

Include sample DB loader scripts in the Campaign install

Sample DB loader scripts are now conveniently accessible in the CAMPAIGN_HOME/SampleDBLoaders folder. Users
will find sample scripts tailored for various databases, including SQL Server, DB2, Informix, MariaDB, MySQL, OneDB,
Oracle, and PostgreSQL.

SQLONConnect - support for headers from SiteMinder

In this release, support for a new token, <session_token::x>, has been introduced. To ensure clarity and precision,
users are now required to specify any additional header variable names explicitly under Affinium|suite|security|
loginModes|siteMinderPartitionLogin. This approach replaces the use of a generic placeholder such as "x variable."

Allow table search with letters in table name

This enhancement enables users to locate tables by any character or substring within the table name, expanding the

search capability beyond matches occurring only at the beginning of the name.

Multiple kafka

Users now have the capability to effortlessly manage multiple Kafka instances through the provided template. This
enhancement enables users to configure and utilize these Kafka instances to efficiently produce data from Campaign
Process Boxes (PBs) such as Snapshot, Maillist, and Calllist.
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Customized email templates for Flowchart Notifications

This customization capability ensures that flowchart status

providing personalization.

Fixed defects in Unica Campaign

The following defects were fixed in Unica Campaign 12.1.7.

notification emails align perfectly with users' needs,

Issue ID Description

HMA-359679 After upgrading to v12.1.5, only one specific Japanese
Character in Platform becomes a weird character.

HMA-358622 System Tables mapping disappeared after upgrade. All
Mailists, Track and Response Process boxes grayed out

HMA-358226 Schedules are not working in 12.1.6 when InteractDT and
Campaign are deployed in the same JVM.

HMA-357601 End time changing when editing exclusion

HMA-356667 Error 10404 runing Process Link

HMA-355914 unica_svradm leaves "connected" acsvr's up even when
user is logged out or session times out.

HMA-355819 corporatetheme.css not working in 12.1.5

HMA-355553 Issue with tables remaining tokenized in SQL statements
that Campaign creates

HMA-355523 Mapped table not visible in the table mapping

HMA-355145 Issue with Audience Customer

HMA-354896 Change in prefix of persistent derived field from version
8.6t0 10.1

HMA-354697 Unica Kafka Posting Keys in Snapshot Process Box

HMA-354440 Clear Contact History functinality not working || Call List
|| Log tab

HMA-353678 Unable to delete flowchart from Ul when Enable Sched-
uler = False from Unica Platform | Scheduler

HMA-353418 Flowchart entry deleted from UA_LFLOWCHART but ses-
sion file is still there

HMA-350440 The mandate for 'Hive Loader requirement ' is miss-
ing/not clear in the document.
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HMA-331720

Security Vulnerability 4€“ Improper Error Handling

Known issues in Unica Campaign

Unica Campaign 12.1.7 includes the following known issues.

Issue ID Description

HMA-341415 HCL OneDB Datatype mismatch issue between Unica
system tables and temp tables

HMA-360170 For Postgres Getting with Track PB "operator does not
exist: numeric = character varying"

HMA-360154 Postgres :: CSV File's columns are not getting marked as
YES when used in flowchart

HMA-359362 Weblogic 14 :Lock/Unlock & Concurrent user features
might not work with real time due to request time out

HMA-358929 ORA-01400: cannot insert NULL For In-Use

HMA-359697 Postgres - WAS - Automatic DS creation seems to be
failed

HMA-359417 v12.1.7 : CAMPAIGN_PB Topic name is not coming in
Campaign Kafka Template
Workaround : The user is required to manually insert
CAMPAIGN_PB or any specified topic name into the new-
ly created Kafka Template.

HMA-357497 Cannot delete a flowchart in 12.1.4 while scheduler dis-
abled

HMA-354628 Show Decimal Separator According To Locale In Cam-
paign Fusion

HMA-353806 Time required to open any campaign or flowchart is in-
creased.

HMA-353697 Tooltip Fluctuations On New Ul

HMA-352709 Flowchart lock/unlock not reflecting if user is already in
view mode.

HMA-353535 FC run label is not updated with current fc run status

when FC run triggered through Collaborate
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HMA-344732 Flowchart Running Icon on toolbar keeps spinning even
when flowchart is in Paused state

HMA-344476 Search optimize session not working 2nd time

HMA-343764 Weblogic : partial Error messages are displayed for Cam-

paign Error messages

HMA-342778 Publish Offer - Campaign- Contact are not getting gener-
ated as per package id in Campaign table for multiple of-
fers

HMA-327170 For Docker environment, getting a "Failed to load data"

error on Schedule management page if user continuously

clicks on pagination (Next button).

HMA-338254 BigQuery database : Cell size limit causing the Flowchart
to hang

HMA-337564 BigQuery : table mapping, default string size is taken as
Maximum

HMA-330433 User is not able to login to platform after upgrade to

12.1.1 in case Deliver is configured.
Resolution
Execute below query on Platform database :

select * from usm_role_role_map where role_id = (select
ID from usm_role where name='Deliver_admin' and appli-
cation=101 and partition_id=<>)

Specify actual partition id in above query , default for par-
tition1, partition id =1, it varies for multiple partitions.

If above result in more than one row , contact HCL sup-
port to help in executing below delete query - delete one
of the duplicate record of *D*eliver_admin role by running

below query :

delete from usm_role_role_map where role_id = (select ID
from usm_role where name='Deliver_admin' and applica-
tion=101 and partition_id=<>) and parent_role_id=<parti-
tion_id>

For example, for partition id =1,
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delete from usm_role_role_map where role_id = (select ID
from usm_role where name='Deliver_admin' and applica-
tion=101 and partition_id=1) and parent_role_id=1

HMA-306095

Production documentation links on Campaign installer
are broken. See the documentation available along with

product installers.

HMA-310126

eMessage instances in Campaign uninstall folder -
these can be ignored. Unica no longer support eMes-

sage.

HMA-312231

Campaign swagger APIs will not work only on swagger
page when marketing platform login method is set to

Web Access control.

HMA-13460

When the Export to File option is unchecked on the Fulfill-
ment tab of the Mail List process, the Summary File op-

tion is enabled but should not be.

HMA-175825

When def aul t Behavi or WaenQut put ToFi | e iS set to Create
New Fi | e, it works only when you select a new output (ex-
port) file for the first time. If you try to change the exist-
ing output file and select a new output file, then the op-
tion Append to Existing Data gets selected by default. It

can be changed manually to create New File.

APAR 198495, P0O05293, 198494

For a custom macro, if a user account has assigned as
Not Granted permission for a stored object (Custom
Macros, Flowchart Templates, Stored Derived Fields,
etc.), the custom macro can be used to edit, delete, add,
move all stored objects regardless of permissions.

HMA-204347 LARGE_DATA: Browser Crash - Mail List process box with
700 segments - Save with 512 offers to each segment.

HMA-211253 File-based input with multiple columns containing date in
different format does not read the date correctly.

HMA-212890 Boolean type column on Amazon Redshift is recognized
as 'Test' field type in table mapping.

HMA-220474 When the column name of the source table contains

Non-ASClII characters and is long (probably longer than
10 x 3bytes characters in UTF8), the Snapshot process
does not run because the temp table is not created.
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HMA-220705 Profiling count for Dimension table fields is incorrect and
profiling percentage is displayed as 100% even if profil-
ing is in progress.

APAR 222047, P006172, 222049 Unica Campaign extract process does not write to DB2
database when flowchart is configured with two extract
processes and the second extract process contains a de-
rived field that uses French accented characters in the

name of the derived field.

APAR 225568, PO06304, 225572 t enpt abl epost execut i onsql is not run when selecting core-

metrics segment.

HMA-230340 Inconsistent behavior for the Mail list process is ob-
served when the data filter is assigned to Effective date
on the Parameters tab in a new Mail list process when
compared to an edited existing Mail list process. The
Mail list process does not output a datetime derived field
in the output log file. Changing the effective date para-
meter values might cause execution failure of the Mail
list.

HMA-230606 In a flowchart where fields are extracted and used in a
Mail list process, the fields under Extract Node on the
Personalization tab of the Mail list process are different

before and after running the process.

HMA-231859 While using the Chrome browser, it takes around 20 sec-
onds to respond while loading the Personalization tab
of the Mail list process if it contains large number of
treatments and offers assigned. For example, a Mail list
process with 250 cells, each cells with multiple offers,
each offer having multiple attributes.

HMA-232502 A Mail list performance issue occurs when the user
changes the input in any way and there is a delay when
initially switching tabs. After the user changes the input
and switches to the Treatment or Process tab for the first
time, there is a delay of around 10-15 seconds depending
on the number of inputs selected. After this initial delay,

there is no delay until the input is changed.

HMA-232835 The Campaign application performance is affected and
sometimes an exception error message is displayed on

the Campaign pages when the application is used for

a longer time (some days) with continuous usage. You
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must restart your Campaign web application and Cam-

paign Listeners.

HMA-238789

While using the Chrome browser, when a user opens a
Mail list with 600 cells having multiple offers assigned to
each cell, the application stops responding. While using
the Internet Explorer 11 browser, nothing is displayed in

the Mail list process box.

HMA-239142

When the Audience process fails because of an incor-
rect Count filter expression, and the user removes the
filter expression, adds a Condition, and runs the Audi-
ence process again, the process fails. The Condition is
not considered and instead the previous Count filter ex-
pression is used resulting in the failure. To run the Audi-
ence process successfully, you must re-open the Audi-
ence process configuration window, click the Condition,
Save and Close. The Audience process now considers

the Condition and runs successfully.

HMA-271642

A"Please wait..... " message is displayed multiple
times in console mode installation while upgrading from

version 10.1 and also for new Installation

HMA-271676

The Extract table on the DB2 and Oracle databases is not
deleted when In-DB optimization is unchecked.

HMA-272253

The Campaign application performance is affected when
a user opens the Table mapping window and more than
500 tables are mapped.

HMA-2968

Hot keys are not implemented on most of the windows.
In the Dojo implementation it is not possible to use key-
board shortcuts to activate certain functions. Instead the

user must click buttons.

HMA-PMR 266519, 75262

Clicking Return to previous page distorts the user inter-
face in some cases. Use the links within the products to

navigate, rather than the browser controls.

N/A

When Unica Campaign is deployed in an application serv-
er cluster environment with 80 port, the Campaign navi-
gation URL should not contain this port number. For ex-
ample: http: // <host >. <donwi n>: 80/ Canpai gn shoul d be

changed to http://<host>. <domai n>/ Canpai gn. Change the
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value of the serverURL property under Campaign|naviga-

tion on the Settings > Configuration page.

N/A Mail List process box gets unconfigured with error

"31606: History table are changed" on Flowchart run.

1. There is no issue if the history tables are mapped
prior to building a flowchart and adding a Mail
List process.

2. If you do not follow step 1, you can still map the
history tables after the error appears. If you edit
the flowchart and configure the process box, the

process will run.

N/A After migrating non-ASCIl data to Campaign, in some
cases you cannot open Campaign flowcharts on the tar-
get system. Session flowcharts open successfully. To
work around this issue, remigrate the campaigns in over-

write mode. You can then open the flowcharts.

TT 062333 Information related to associated products does not ap-
pear in offer on Marketing Operations. When an offer cre-
ated in Campaign with products associated with it is im-
ported in Marketing Operations, information about the
associated products is not available in Marketing Opera-

tions.

HMA-270655 Table Mapping : Table name containing @ is support-
ed while mapping a table, special characters like @ are
should not be supported in Table names. Since Table
name containing @ is supported since some time, this

functioning is not updated now.

HMA-283637 When user has one maillist PB configured in the flow-
chart and he adds another maillist PB in the same flow-
chart, it is observed that All the values from already con-
figured in treatment tab, Parameters tab, Personalisation
tab of new Maillist PB appear automatically in any new

dragged maillist PB.

HMA-281389 While running Campaign in the Upgrade mode, the in-
staller should read the installation properties files from

the previous version response files as we had that re-

sponse available at the install location from the previ-



Unica Campaign V12.1.7 Release Notes | 1 - Release Notes for version 12.1.7 | 18

ous installation. However, it does not read the installation

properties files from the earlier version response files.

HMA-280623

In Sample PB if we specify '3' in "# of Samples/Output
Cells" field and Configure [sample1] with 3 samples hav-
ing sample sizes as 50%, 50% and "All remaining records"
respectively based on "Random Sample method" then
after running Flowchart if we reopen the Sample PB
"Process run results will be lost. Continue?" message is
displayed in sample PB when remaining All check boxed
is check.

HMA-283101

CHROME: "Unable to notify roles/permission changes

to Campaign, Deliver OD may be out of sync". On click-
ing save changes for the Security Policy displays the
following pop-up, this happens just first time after user
logs in and changes anything in the policy and clicks
save changes. Also, this is reproducible just on CHROME.
Tested on Chrome V64 and V65.

HMA-282844

Campaign Offer doesn't sort on 'Channel’ & 'Eff./Ex-
p.Dates'. After clicking on every column the offers be-
low it should be sorted in ascending order. If you click on
the same column the second time, the offers beneath it

should be sorted in the descending order.

HMA-283695

Segment process box execution failed with extract en-
abled to User database for the IMPALA user DB. This er-
ror does not reproduce when extracting to Unica Cam-

paign server.

HMA-284436

Platform.war and campaign.war in ear file deployment
will not work in Weblogic 12.2.1, work around is to deploy

campaign.war and unica.war separately.

HMA-288228

If the date field uploaded to IMC side is not in mm/dd/
yyyy format, the email process box fails to execute. This
data format is required by IMC Importlist API. It works
accurately if DELIM_M_D_YYYY(mm/dd/yyyy) format

is used for date while uploading to IMC using importlist
API.

HMA-289135

TOMCAT : Occasionally Unica Platform or Campaign
does not gets started after deploying in tomcat applica-
tion server. Workaround : delete Campaign and Platform

directory available inside Tomcat webapps directory and
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delete the content of work directory from the path where

Tomcat is installed.

HMA-304945 Refresh command does not refresh the master listener
priority or weight, if you need to make changes in priority
or weight you require to take a downtime and restart the
application.

HMA-312445 Link Process box - sending data only for the first input
cell selected to link.

UL-285 Connection Salesforce - Subsequent Salesforce actions

are failing for Update (Lead/Contact) intermittently.

UL-250 Connection Mandrill - Intermittenly stop sending emails

to targeted audiences.

UL-281 Connection Mandrill - Subject line with non english char-

acters - mandrill not sending email to user.

UL-259/UL-242 Connection Mailchimp/Mandril - results would be avail-

able for 1000 users only.

uL-214 MailChimp/Mandril - Audience value is getting changed

to id field after selection or reopening process box.

UL-194 MailChimp/Mandril - In Mandrill template if merging field
added as localized character - personalization is not
working.

UL-257 Link Connections page takes time to load in the Cam-

paign process box.

UL-231 Twilio Connection - Only 5 fields are supported for per-
sonalization in SMS body/text area.q

UL-279 Connection MailChimp - Branch run or single link process
box run is not supported with Link process box with
Mailchimp connection. You will need to execute com-

plete flowchart.

uL-287 Link process box fails when no output data.

NA Unica Campaign and Unica Link applications urls should
be having same domain names. Unica Campaign and
Link applications deployed on different domains will not

work.

UL-189 Connection Mandrill/MailChimp- Emojis are not working

in Mandrill and MailChimp connector Mail Subject line.
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HMA-313650

Platform Scheduled flowcharts are not getting execut-

ed afterupgrade.Use the quartzjobtool to update sched-
uler jobs. This is a requiredstep. If this upgrade tool is
not run, any existing scheduled job willfail to start. The
quartzjobtool is in the tools\bin directory underUnica
Platform installation. Run this utility from the tools \bindi-
rectory.Example command (Windows): quartzjobtool.bat-

Example command (Unix): ./quartzjobtool.sh

HMA-306383

UBX registration utility is failing with error Caused by: ja-
va.lang.ClassNotFoundException: org.jboss.logging.Basi-
cLogger error

HMA-316802

MariaDB]:CODE 704: File write error. while extracting ex-
tracted fields and table fields to database server through
Segment PB

HMA-338395

v12.1.3: Campaign : Selecting export to Kafka makes
Snapshot PB unconfigured. Needs workaround to run

HMA-338387

Known issues in Optimize

The following are the Known Issues for Optimize in V12.1.7

For version 12.1.3, the copyright year is incorrect in the
Fed Response File ResponseFi | es. tar. gz.

Issue

Issue ID Description

Scores entered manually in the score matrix are

not considered while optimizing the contact list.

Defect 194109

Scores entered manually should be
considered for calculation in the
Customer Capacity rule. However,
while applying the Customer Capaci-
ty rule, scores in the PCT are consid-
ered, and all customer records are re-

moved in the optimized list.

Campaign Optimize summary report is incorrect.

Defect 176368

If offer versions are used in a rule, the
report that shows pre-optimization
versus post-optimization counts will
always report the pre-optimization
count of records as 1. The post-opti-

mization counts will be correct.
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Issue Issue ID Description

After upgrading Campaign to 9.1, Optimize listener | Defect 81245

can no longer be stopped via ACOSer ver . sh. Users must upgrade Unica Cam-
paign and Unica Optimize together.
If they cannot, they will need to stop
the Unica Optimize listener manual-
ly through the task manager/kill com-
mand.

Error messages for the ACOOptAdmin utility do DEF051284 When you run the ACOOptAdmin

not display according to non-English locales. command line utility in a locale other
than English, error messages do not
display according to the specified lo-
cale. The error messages display only
in English.

unprocessabl es_sessi oni d. csv might con- | DEF054841 In some scenarios, a few of the cus-

tain some customers who receive offers. tomers who get offers might be
present in the unpr ocessabl es_-
sessi oni d. csv file.

Incorrect optimization result with Custom Capaci- | DEF058362

ty rule in specific circumstances. A customer that satisfies the follow-
ing criteria might receive fewer offers
than wanted:

» The customer has an even
number of proposed transac-
tions.

« Each of these transactions
has the same score.

« This score is a low value.

Some labels display incorrectly in Japanese, Chi- | DEF059595 Some translated labels are displaying

nese, and Korean.

incorrectly. For example, when you
edit the score matrix manually, the
vertical label on the right side of the
table displays upside down. Also, for
optimization rules that contain cus-
tomers in the segment, the segment
label displays on two lines.
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Issue

Issue ID

Description

Offer filtering summary report displays an incor-
rect count of Proposed Contacts that are removed

by each Custom Capacity rule.

DEF059805

The Offer Summary Report displays
incorrect counts in the "Removed By
This Rule" column for Custom Ca-
pacity rules if the participating Flow-
chart for this Unica Optimize session
contains multiple contact dates and
multiple offers that are made to each

customer on different channels.

Issues with offer version query builder.

DEF060676

There are several minor issues with

the offer version query builder:

- For custom attributes with the
Form Element Type of Select
Box, the offer version query
builder does not use the se-
lect box. You must enter the
value manually.

» When the group level is re-
moved, the subgroup condi-
tions are added to the parent
condition, and vice versa.

« All arithmetic operators are
displayed for a string variable,
but only equal and not equal
apply.

« Defined length validations for
attributes are not verified up-

on input for conditions.

Offer version rules that contain dates do not pro-

vide expected optimization results.

DEF061554

If you create an offer version con-
dition that includes a date, such as
the offer parameter "valid end date”
equals "12/31/2011", the rule con-
taining offer version condition might
not be satisfied; however, the rest of
the rules will work as expected.

Rule exceptions that span calendar years give in-

correct results.

DEF061639

If you create a rule exception to
a Min/Max # Offers capacity rule
that spans calendar years, such as
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Issue Issue ID Description

07/01/2011 to 06/30/2012, the rule
containing rule exception condition
will not be satisfied; however, the rest

of the rules will work as expected.

<uni ca_svr adn® refresh command does not reflect | HMA-304945 On a running environment, after
the change. changing the master listener priori-
ty, <uni ca_svradn® refresh command

does not reflect the change.

<uni ca_svr adm> refresh command does not delete | HMA-305764 If you delete a listener node from ex-
the node from cluster. isting cluster, <uni ca_svr adm> refresh
command does not delete the node
from cluster. Execution requests are
still observed going to the deleted
node. Restarting the listener solves

this issue. Will be fixed in upcoming

fixpack.
Users are still able to manually interfere in the HMA-306037 When flowchart execution is in
running flowchart when flowchart execution is in progress through SVRADMIN utility
progress through SVRADMIN utility. or using scheduler, user is still able

to manually interfere in the running
flowchart. Will be fixed in upcoming

fixpack.
Known limitations in Unica Campaign
Unica Campaign 12.1.7 includes the following known limitations.
Issue ID Description
305764 For any reason, if users delete the Campaign listener

node configuration from listener cluster configuration

in Unica Platform, while the application is up and run-
ning then users connected to this listener node are not
redirected to another listener. You must restart the Cam-
paign web application. If you require to delete the listen-
er node, take a downtime and restart Campaign web and

listener components.

17202 Error 19024: Cannot delete segment folder if the seg-
ment was deleted from the folder. A segment that is

deleted from a folder remains as an inactive segment
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in the folder. Folders with inactive segments cannot be

deleted. This is working as intended.

185854

Big data: Campaign integration with Hadoop-based Hive
big data as a user data source is not tested on MS Win-

dows operating system.

190621

Big data: Campaign with Hive big data as a user data-
base does not support user table mapping with Base and
Dimension levels up to the fourth level hierarchy. If you
map a Base record table with four levels of dimension ta-
bles in a Select process box, then build a query based on
the fourth level Dimension table, the query fails with Er-
ror 11528. This issue should not affect big data users be-
cause multiple dimensions should not be needed. By def-
inition, a big data source has a large table of records split

across Hadoop nodes (such as HDFS).

194095

For Redshift database, the error message "Unsupported
type timestamps with time zone" is displayed when ex-
porting data from a Snapshot process box. Timestamp
with timezone is an unsupported PostgreSQL data type

on Amazon AWS.

195581

While running a Campaign flowchart, if listener crashes
or is stopped, user is not able to access the running flow-
chart from the Ul. Requests are being served by another
node of the cluster but while accessing the flowchart, a
pop-up message says "listener failover occurred..." It may
be necessary to restart the master listener.

232032

User can start only one Campaign listener on one server
(machine) in case of Listener clustering.

PMR 243195, 244148

When a column that has the Greek Letters A and B is pro-
filed in Campaign, the system returns only A along with
the count of all the records. After the fix, some of the
non-English characters, which differ only in case (like é
and E in French), are counted as two different values in
profiling. English language characters are not counted as

case sensitive.

244482

Deep search lists all the Campaigns that are created
through Marketing Operations projects when Campaign -
Marketing Operations integration is on. Campaigns that

are created through Marketing Operations projects when
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Marketing Operations - Campaign integration is enabled)
are not listed on Campaign list page and are only avail-
able on the Marketing Operations project listing page.
Users who do not have the permission to access Market-
ing Operations are able to access campaigns which are
created through Marketing Operations projects through
Deep search results.

248943 If the user profile database is changed (change in the
table column values of audience record) for fields oth-
er than sync fields and the user runs the Email process
again, a negative count is returned for the DUPLICATES

parameter from Engage in the Campaign flowchart log.

N/A Big data: To perform the UPDATE operation on any
process boxes in a flowchart, ensure that your HIVE ta-
bles are configured as transactional tables such that they
support the ACID property. This is a key feature intro-
duced in HIVE version 0.14.

N/A Interact when configured with IBM WebSphere Applica-
tion Server: You must configure IBM WebSphere JVM to
use JDK 1.7. When IBM WebSphere Application Server
8.5.5.x is configured with JDK 1.7 and HTTPS communi-
cation, you must use IBM JAVA SDK version 7.0.8.10 or
higher.

N/A Using multiple SQL statements for raw SQL queries is not
currently supported on big data user datasources. For re-
lated information, search the IBM Knowledge Center for

Hive query language conformance.

N/A Dialog behavior: In certain cases, it is necessary to click

twice in order to activate a field or change a field value.

N/A The roni t or Enabl edFor Del i ver configuration property in

Canpai gn| noni t ori ng is not currently used.

N/A Relevant products limitation: When offer management is
performed from Unica Plan, the "relevant products" func-
tionality, which relates product IDs to offers, is not avail-

able.

N/A Blank or incorrect results from derived fields in a Mail

List process. This can occur in a process box that uses
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a derived field that calls a Generated field (UCGF) that
changes value.

Do not use a UCGF in a Mail List derived field if the UCGF
is not constant. Also, from the Parameters tab, do not
create a derived field to call a UCGF to populate offer at-
tributes.

N/A

Profiling a Campaign Generated Field (UCGF) does not
yield correct results. Some UCGFs have a value accord-
ing to the cell or the offer being processed. For cell-relat-
ed UCGFs, only the value associated with the first cell ap-
pears during profiling.

N/A

The default value for a custom cell attribute does not
appear when you open the target cell spreadsheet. Al-
though the default value is not initially displayed, it will be
used. The value can be displayed or changed by clicking
or opening and editing the custom cell attribute in the tar-
get cell spreadsheet.

N/A

The ua Usr ResponseType. Nane field cannot contain a left

parenthesis followed by a single quote.

N/A

Use unique TenpTabl ePr ef i x for each data source when
mapping multiple data sources to same physical data-

base.

If you mapped multiple data sources in Unica Campaign
to the same physical database, and you use the same
TenpTabl ePref i x for more than one of the data sources,
when you use the cleanup utility to delete orphaned temp
tables, it may falsely identify temp tables as orphaned,
when they are in fact legitimate temp tables defined from

a different Unica Campaign data source.

Any deleted temp tables will automatically be recreated
when you rerun affected flowcharts, but as a best prac-
tice, use a unique TenpTabl ePref i x for each data source
when mapping multiple data sources to the same physi-

cal database.

If the data sources defined in Unica Campaign map to
different schemas in the database, another solution is

to ensure that the database user who runs the cleanup
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utility does not have privileges to drop tables in other

schemas in the same database.

161323 The error "Login failed. Error 10553" can occur if you try
to log in to the Campaign utilities when the Unica Plat-
form | Security | login method is set to Windows inte-
grated login or Web access control. To avoid this issue,
change the login type to LDAP or Platform prior to using
the Campaign utilities..

176377 DB2 10.5 BLU for user DB: No indexing requirement for
temp tables in Unica Campaign datasource. DB2 10.5
(with BLU feature ON) does not require indexing in Uni-
ca Campaign. Unica Campaign has certain properties for
datasources, such as TempTablePreTruncateRunScript,
TempTablePostExecutionSQL, and PostTempTableCre-
ateRunScript, where you can provide SQL or scripts to
create indexes on user database tables. If you are using
DB2 10.5 as a customer database, with the BLU feature
ON, you do not need to configure any of these temp table
properties.

201,968,200,241 If two process boxes are moved very close together

in a flowchart, the direction of the connection arrow
changes. This limitation affects the visual representation
of the arrow. The process data flow is not affected. The
workaround is to move the process boxes farther apart

so the arrowhead changes back to the correct direction.

211293 In Unica Campaign, the built-in macro Current_Date() re-
sults in an error when executed against a Hive 1.2 based
Big Data instance. The Hive ODBC driver does not sup-
port the Current_Date macro to obtain interval values. For
example, executing the following query results in a Hive

error:

SELECT DISTINCT customerid FROM Customer_date
WHERE ((Customer_date.my_date_mmdyyyy - CURREN-
T_DATE()) >= 7)

Error: Hive 2 Internal error: unsupported conversion from

type: interval_day_time
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Workaround: To use the Current_Date function in a RAW
SQL query on Hive with Hortonworks, execute SQL in the
following format:

SELECT DISTINCT customerid FROM Customer_date
WHERE (current_date() - my_date_mmddyyyy ) = interval
'0 0:0:0' day to second

310769

In Unica Campaign, the built-in macro current _pat e()
results in an error when executed against Impala data
source. The Impala ODBC driver does not support the
Current_Date macro to obtain interval values. For exam-
ple, executing the following query results in an error:

INSERT INTO TABLE UAC_133824_5 SELECT DISTINCT
store_id, d_customer_key FROM srvacammo.bast_seg-
ment WHERE (srvacammo.bast_segment.ba_last_trans_-
date > (CURRENT_DATE - 2))

Error: Error while executing a query in Impala: [HY000] :
AnalysisException: Could not resolve column/field refer-

ence: ‘current_date'

Workaround: In raw SQL query, the current _bat e would
not work with Impala, so instead of current _dat e, users

can use now() Or current _timestanp().

213088

If Campaign is installed in a secured environment but
IBM Cognos is in an unsecured environment, Cognos re-
ports will not display when you use Microsoft Internet Ex-
plorer 11. Workaround: If Unica Campaign is configured
with HTTPS, also configure IBM Cognos on HTTPS.

217488

IBM can support the Database Loader for Redshift until
the moment Campaign triggers the Loader Script. Any

problems in execution of the loader script are not sup-

ported by IBM.

223716

Authentication Bypass Using HTTP Verb Tampering

Instead of applying theHttpVerbFilter.class patch, you
can use the following workaround to ensure application
security.

Complete the following steps to update web.xml.
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1. Update the web app tag and set the xsd version
to 3.0.

<web- app
xm ns: xsi ="http://
www. W3. or g/ 2001/ XM_Schena- i nst ance"

xm ns="http://java. sun. conl xm / ns/ j avaee"

xsi : schemalLocati on="http://

java. sun. com xm / ns/ j avaee

http://java. sun. com xm / ns/ j avaee/ web- app_3_
0. xsd"
id="Platforn version="3.0"

met adat a- conpl et e="true">

2. Add the following in web.xml.

<I--[start] WhiteList Htp Verbs -->
<security-constraint>

<web- resource-col | ecti on>

<web- r esour ce- nane>Uni ca_Wi telList_Http_Verb
s</ web- r esour ce- nane>

<url-pattern>/*</url-pattern>

<ht t p- net hod- oni ssi on>GET</ ht t p- met hod- oni ss

i on>

<ht t p- met hod- omi ssi on>POST</ ht t p- net hod- oni s

si on>

<ht t p- met hod- om ssi on>TRACE</ ht t p- et hod- om

ssi on>

<ht t p- met hod- oni ssi on>PUT</ ht t p- net hod- omi ss

i on>

<ht t p- net hod- oni ssi on>DELETE</ ht t p- net hod- om

i ssi on>

<ht t p- met hod- om ssi on>PATCH</ ht t p- et hod- omi

ssi on>
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<ht t p- met hod- oni ssi on>0OPTI ONS</ ht t p- net hod- o

m ssi on>

<ht t p- net hod- oni ssi on>HEAD</ ht t p- net hod- oni s
si on>
</ web-resource-col | ection>
<aut h-constraint/>
</ security-constraint>

<l--[Tend] WiteList Htp Verbs -->

283805

IBM Websphere Application Server 8.5.5 Fix Pack 12 re-
quires IFPI85892 to run HCL Unica application.

283544

On Oracle 12.2 database server following parameters
needs to be added in sqlnet.ora file located under OR-
ACLE_HOME/network/admin/SQLNET.ALLOWED_LO-
GON_VERSION_SERVER

User will need to consult with DBA to provide appropriate
value to this parameter. Please refer this link for details:
https://docs.oracle.com/database/121/NETRF/sqlnet.ht-
m#NETRF2016

N/A

Campaign Integration with Watson Marketing Assistant

is not supported on Internet Explorer.

286705

Two events get generated on the Campaign history tab
when user pauses the Campaign flowchart from Opera-

tional monitoring.

287100

History tab data remains in UA_History table even after
deleting the Campaign

290172

Cutting off right contents from Relevant offers window.

Workaround: The size of text, apps and other items - un-
der Display should be set to 100%.

312318

Campaign flowchart run - when executed as complete
flowchart generates a unique runID and its executed the

flowchart along with mailchimp process box.


https://docs.oracle.com/database/121/NETRF/sqlnet.htm#NETRF2016
https://docs.oracle.com/database/121/NETRF/sqlnet.htm#NETRF2016
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Next time when Campaign user tries to run the single
process box - it does not generate unique runID and thus
process box execution failed.

312296 HTTPS(Invalid certificate) HIP instance is not supported
in IE11 for Link PB and Manage Link Connections page.

312320 MailChimp - Audience value is getting changed to oth-
er format f239295fe8 (in alphanumeric format) if we re-
open correctly configured Link PB. The workaround is
to hit the Fetch button adjacent to the field which will re-
fresh the value of the user-friendly string value.

312567
Campaign installer failed to update Insights report files

when installed using non-root user on Unix environment.
To overcome this user would need to update Insights re-

port file manually after installation is completed.
1. Navigate to <PLATFORM_HOME>/Insights/tools/bin/

2. For UNIX:

« Grant read, write, and execute permissions to
-bPat h=<Report fol der path> for the installation
user.

« Grant execute permission to the installation user

using the following command.

chnod 755 insightsDBUtil. sh

3. Execute command to update the Campaign Insights

report files.

./insightsDBULtil.sh -ds=CampaignDS -bPath=<Report
folder path> -DBType=<databasetype> -URL=JDBC con-
nection URL> -user=<database user> -pwd=<database

password>

For more details refer Unicalnsights12_1InstallationCon-

figurationGuide

313216 Link: Unica application on HTTPS and unica Link on

HTTP does not render the Manage links connections

page.
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Known limitations in Unica Optimize

Unica Optimize includes 12.1.7 includes the following known limitations.

Issue Number Description
Strings in the production or test pop- | Defect 176920 In the case of a non-English setup, the strings in the pro-
up window are not translated. duction or test pop-up window are not translated.
The MailList process fails with the Defect 170951 Change the value of UseTempTablePool from TRUE to
following database error: orA- 00999: FALSE in UA_SYSTEM_TABLES. The MailList run will end
I NVALI D VI EW NAME. successfully.
Unica Optimize does not termi- Defect 164875 In case of a schedule run of a Unica Optimize session by
nate the uni ca_acsvr process that is using the Unica Platform Scheduler, you observe multiple
opened during a run. uni ca_acsvr login processes. These processes might ter-
minate automatically after some time.

A DB2 database user change of sys- | Defect 155876 To avoid having a session fail, the DB2 database admin-
tem tables causes a Unica Optimize istrator should remove indexes.
session to fail when the administra-
tor has an index with the same name.
In a Unica Optimize report, offers by | Defect 102889

. The following issues were noticed while printing the of-
type and segment do not get printed ) ) o
as desired. fers by type and segment in a Unica Optimize report.

1. The preview window does not scroll, unless it is
resized.

2. While printing it does not print everything, but
only what fits in A4 size. Printing options do not
seem to make any difference.

Negative scores cause inaccurate DEF041400
. If you use negative scores, rule crediting in the Offer Fil-
rules crediting.
tering Summary report might not be accurate.
Offers with negative scores are given to meet minimum
requirements only.
Cells that are linked to TCS with offer | DEF061355 If the Optimize process is connected to one or more cells

assignments do not appear in Opti-

mize process.

and the upstream cells are later linked to top-down cells
defined in the Target Cell Spreadsheet process (TCS),
the offers that are assigned in the TCS do not automat-
ically appear in the Optimize process. Link to any top-
down cells in the TCS before you connect those cells to

an Optimize process. Otherwise, you must either manual-
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Issue Number Description

ly assign the same offers within the Optimize process, or

delete the Optimize process and re-create it.

Running the ACOOptAdmin utility DEF046832 You cannot use the ACOOptAdmin utility with one-way
with one-way SSL requires more set- SSL until you register a security certificate, specify a host
up. name and domain, and configure SSL_Options in the

ACQOOpt Admi n. bat file.

Unable to run the session in first at- DEF055010

. If you use the kill command to stop uni ca_acosvr, the
tempt when unica_acosvr process

next time you attempt to run a Unica Optimize session,
stopped.
it might fail with the following error: An unknown cormmuni -
cation failure has occurred with the Optimze server

process.

Workaround - Run the Unica Optimize session again to

complete it successfully.
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